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Buku Panduan

NOTE

This manual is in the process of being revised to cover the latest stable
release version of
KiCad. It contains some sections that have not yet
 been completed. We ask for your
patience while our volunteer technical
writers work on this task, and we welcome new
contributors who would like
to help make KiCad’s documentation better than ever.

Hak Cipta

This document is Copyright © 2010-2023 by its contributors as listed below. You may distribute it and/or
modify it under the terms of either the GNU General Public License (http://www.gnu.org/licenses/gpl.html),
version 3 or later, or the Creative Commons Attribution License
(http://creativecommons.org/licenses/by/3.0/), version 3.0 or later.

All trademarks within this guide belong to their legitimate owners.

Kontributor

Jean-Pierre Charras, Fabrizio Tappero, Wayne Stambaugh, Graham Keeth

Penerjemah

Triyan W. Nugroho.

Umpan balik

The KiCad project welcomes feedback, bug reports, and suggestions related to the software or its
documentation. For more information on how to sumbit feedback or report an issue, please see the

instructions at https://www.kicad.org/help/report-an-issue/

http://www.gnu.org/licenses/gpl.html
http://creativecommons.org/licenses/by/3.0/
https://www.kicad.org/help/report-an-issue/
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Introduction to the KiCad Schematic Editor
Deskripsi
The KiCad Schematic Editor is a schematic capture software distributed as a part of KiCad and available
under the following operating systems:

Linux

Apple macOS

Windows

Regardless of the OS, all KiCad files are 100% compatible from one OS to another.

The Schematic Editor is an integrated application where all functions of drawing, control, layout, library
management and access to the PCB design software are carried out within the editor itself.

The KiCad Schematic Editor is intended to cooperate with the KiCad PCB Editor, which is KiCad’s printed
circuit design software. It can also export netlist files, which lists all the electrical connections, for other

packages.

The Schematic Editor includes a symbol library editor, which can create and edit symbols and manage
libraries. It also integrates the following additional but essential functions needed for modern schematic

capture software:

Electrical rules check (ERC), sebagai kontrol otomatis untuk koneksi yang hilang atau tidak tepat

Ekspor berkas-berkas plot dalam berbagai format (Postscript, PDF, HPGL, dan SVG)

Pembuatan daftar komponen (Bill of Materials), melalui skrip Python atau XSLT, yang mampu menangani

berbagai format fleksibel.

The Schematic Editor supports multi-sheet schematics in several ways:

Flat hierarchies (schematic sheets are not explicitly connected in a master diagram).

Simple hierarchies (each schematic sheet is used only once).

Complex hierarchies (some schematic sheets are used multiple times).

Hierarchical schematics are described in detail later in the manual.

Konfigurasi Awal
When the Schematic Editor is run for the first time, if the the global symbol library table file sym-lib-table
is not found in the KiCad configuration folder then KiCad will ask how to create this file:
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The first option is recommended (Copy default global symbol library table (recommended)). The default
symbol library table includes all of the standard symbol libraries that are installed as part of KiCad.

If this option is disabled, KiCad was unable to find the default global symbol library table. This probably
means you did not install the standard symbol libraries with KiCad, or they are not installed where KiCad

expects to find them. On some systems the KiCad libraries are installed as a separate package.

If you have installed the standard KiCad symbol libraries and want to use them, but the first option is
disabled, select the second option and browse to the sym-lib-table  file in the directory where the
KiCad libraries were installed.

If you already have a custom symbol library table that you would like to use, select the second option
and browse to your sym-lib-table  file.

If you want to construct a new symbol library table from scratch, select the third option.

Symbol library management is described in more detail later.
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The Schematic Editor User Interface

The main Schematic Editor user interface is shown above. The center contains the main editing canvas,
which is surrounded by:

Top toolbars (file management, zoom tools, editing tools)

Left toolbar (display options)

Message panel and status bar at bottom

Right panel (drawing and design tools)

Navigating the editing canvas
The editing canvas displays the schematic being designed. You can pan and zoom to different parts of the
schematic and open any schematic sheet in the design.

By default, dragging with the middle or right mouse button will pan the canvas view and scrolling the mouse

wheel will zoom the view in or out. You can change this behavior in the Mouse and Touchpad section of the
preferences (see Configuration and Customization for details).

Several other zoom tools are available in the top toolbar:

 zooms in on the center of the viewport.
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 zooms out from the center of the viewport.

 zooms to fit the frame around the drawing sheet.

 zooms to fit every item in the schematic (not including the drawing sheet). For instance, if there are

items placed outside of the drawing sheet, they will be visible after zooming to objects.

 allows you to draw a box to determine the zoomed area.

The cursor’s current position is displayed at the bottom of the window (X and Y), along with the current
zoom factor (Z), the cursor’s relative position (dx, dy, and dist), the grid setting, and the display units.

The relative coordinates can be reset to zero by pressing . This is useful for measuring distance
between two points or aligning objects.

Tombol Hotkey
The +  shortcut displays the current hotkey list. The default hotkey list is included in the Actions
Reference section of the manual.

The hotkeys described in this manual use the key labels that appear on a standard PC keyboard. On an Apple
keyboard layout, use the  key in place of , and the  key in place of .

Many actions do not have hotkeys assigned by default, but hotkeys can be assigned or redefined using the
hotkey editor (Preferences → Preferences…​ → Hotkeys).

NOTE
Many of the actions available through hotkeys are also available in context menus. To
access the context menu, right-click in the editing canvas. Different actions will be
available depending on what is selected or what tool is active.

Hotkeys are stored in the file user.hotkeys  in KiCad’s configuration directory. The location is platform-
specific:

Windows: %APPDATA%\kicad\6.0\user.hotkeys

Linux: ~/.config/kicad/6.0/user.hotkeys

macOS: ~/Library/Preferences/kicad/6.0/user.hotkeys

KiCad can import hotkey settings from a user.hotkeys  file using the Import Hotkeys button in the hotkey
editor.

Mouse operations and selection
Selecting items in the editing canvas is done with the left mouse button. Single-clicking on an object will
select it. Clicking and dragging will perform a box selection. A box selection from left to right will only select
items that are fully inside the box. A box selection from right to left will select any items that touch the box.
A left-to-right selection box is drawn in yellow, with a cursor that indicates exclusive selection, and a right-

to-left selection box is drawn in blue with a cursor that indicates inclusive selection.

The selection action can be modified by holding modifier keys while clicking or dragging. The following
modifier keys apply when clicking to select single items:

Space

Ctrl F1

Cmd Ctrl Option Alt
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Modifier Keys
(Windows)

Modifier Keys
(Linux)

Modifier Keys
(macOS)

Selection Effect

Toggle selection.

Add the item to the existing selection.

+ + + Remove the item from the existing
selection.

long click long click or long click or Clarify selection from a pop-up menu.

The following modifier keys apply when dragging to perform a box selection:

Modifier Keys
(Windows)

Modifier Keys
(Linux)

Modifier Keys
(macOS)

Selection Effect

Toggle selection.

Add item(s) to the existing selection.

+ + + Remove item(s) from the existing
selection.

Selecting an object displays information about the object in the message panel at the bottom of the window.

Double-clicking an object opens a window to edit the object’s properties.

Pressing  will always cancel the current tool or operation and return to the selection tool. Pressing 
while the selection tool is active will clear the current selection.

Left toolbar display controls
The left toolbar provides options to change the display of items in the Schematic Editor.

Ctrl Ctrl Cmd

Shift Shift Shift

Ctrl Shift Ctrl Shift Cmd Shift

Alt

Option

Ctrl Ctrl Cmd

Shift Shift Shift

Ctrl Shift Ctrl Shift Cmd Shift

Esc Esc
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Turns grid display on/off.

Note: by default, hiding the grid will disable grid snapping.
This behavior can be changed in the
Display Options section of Preferences.

Display/entry of coordinates and dimensions in inches, mils, or millimeters.

Switches between full-screen and small editing cursor (crosshairs).

Turns invisible pin display on/off.

Switches between free angle, 90 degree mode, and 45 degree mode for
placement of new wires,
buses, and graphical lines.

Opens and closes the docked hierarchy navigator pane.
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Membuat dan Mengedit Skematik
Pengenalan
A schematic designed with KiCad is more than a simple graphic representation of an electronic device. It is
normally the entry point of a development chain that allows for:

Melakukan validasi berdasarkan suatu aturan tertentu (Electrical Rules Check) untuk mendeteksi

kesalahan dan kelalaian.

Automatically generating a bill of materials.

Pembuatan netlist untuk perangkat lunak simulasi seperti SPICE.

Defining a circuit for transferring to PCB layout.

A schematic mainly consists of symbols, wires, labels, junctions, buses and power symbols. For clarity in the

schematic, you can place purely graphical elements like bus entries, comments, and polylines.

Symbols are added to the schematic from symbol libraries. After the schematic is made, the set of
connections and footprints is imported into the PCB editor for designing a board.

Schematics can be contained in a single sheet or split among multiple sheets. In KiCad, multi-sheet

schematics are organized hierarchically, with a root sheet and sub-sheet(s). Each sheet is its own
.kicad_sch  file and is itself a complete KiCad schematic. Working with hierarchical schematics is described
in the Hierarchical Schematics chapter.

Schematic editing operations
Schematic editing tools are located in the right toolbar. When a tool is activated, it stays active until a

different tool is selected or the tool is canceled with the  key. The selection tool is always activated
when any other tool is canceled.

Selection tool (the default tool)

Highlight a net by marking its wires and net labels with a different color.
If the PCB Editor is
also open then copper corresponding to the selected net
will be highlighted as well. Net

highlighting can be cleared by clicking with
the highlight tool in an empty space, or by using
the Clear Net Highlighting
hotkey ( ).

Display the symbol selector dialog to place a new symbol.

Display the power symbol selector dialog to place a new power symbol.

Draw a wire.

Draw a bus.

Draw wire-to-bus entry points. These elements are only graphical and do not create
a
connection, thus they should not be used to connect wires together.

Esc

~
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Place a "No Connect" flag. These flags should be placed on symbol pins which
are meant to be
left unconnected. "No connect" flags indicate to the Electrical
Rule Checker that the pin is
intentionally unconnected and not an error.

Place a junction. This connects two crossing wires or a wire and a pin, which
can sometimes be
ambiguous without a junction (i.e. if a wire end or a pin is
not directly connected to another
wire end).

Place a local label. Local labels connect items located in the same sheet.
For connections
between two different sheets, use global or hierarchical labels.

Place a net class directive label.

Place a global label. All global labels with the same name are connected, even
when located on
different sheets.

Place a hierarchical label. Hierarchical labels are used to create a connection
between a
subsheet and the sheet’s parent sheet. See the
Hierarchical Schematics section for more
information
about hierarchical labels, sheets, and pins.

Place a hierarchical subsheet. You must specify the file name for this subsheet.

Import a hierarchical pin from a subsheet. This command can be executed only on
hierarchical
subsheets. It will create hierarchical pins corresponding to hierarchical
labels placed in the
target subsheet.

Place a text comment.

Place a text box.

Draw a rectangle.

Draw a circle.

Draw an arc.

Draw lines.

Note: Lines are graphical objects and are not the same as wires
placed with the Wire tool. They
do not connect anything.

Place a bitmap image.

Delete clicked items.

Grids
In the Schematic Editor the cursor always moves over a grid. The grid can be customized:

Size can be changed using the right click menu or using View → Grid Properties…​.
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The default grid size is 50 mil (0.050") or 1.27 millimeters.

This is the recommended grid for placing symbols and wires in a schematic, and for placing pins when

designing a symbol in the Symbol Editor.

NOTE

Wires connect with other wires or pins only if their ends coincide
exactly. Therefore it is
very important to keep symbol pins and wires
aligned to the grid. It is recommended to
always use a 50 mil grid when
 placing symbols and drawing wires because the KiCad
standard symbol
library and all libraries that follow its style also use a 50 mil grid.
Using a
grid size other than 50 mil will result in schematics without
proper connectivity!

Smaller grids can also be used, but this is intended only for text and symbol graphics, and not recommended

for placing pins and wires.

NOTE Symbols, wires, and other elements that are not aligned to the grid can be
snapped back to
the grid by selecting them, right clicking, and clicking
Align Elements to Grid.

Snapping
Schematic elements such as symbols, wires, text, and graphic lines are snapped to the grid when moving,
dragging, and drawing them. Additionally, the wire tool snaps to pins even when grid snapping is disabled.
Both grid and pin snapping can be disabled while moving the mouse by using the modifier keys in the table
below.

NOTE On Apple keyboards, use the  key instead of .

Modifier Key Effect

Disable grid snapping.

Disable snapping wires to pins.

Editing object properties
All objects have properties that are editable in a dialog. Use the hotkey  or select Properties from the
right-click context menu to edit the properties of selected item(s). You can only open the properties dialog if

all the items you have selected are of the same type. To edit the properties of different types of items at one
time, see the section below on bulk editing tools.

In properties dialogs, any field that contains a numeric value can also accept a basic math expression that
results in a numeric value. For example, a dimension may be entered as 2 * 2mm , resulting in a value of 4mm .

Basic arithmetic operators as well as parentheses for defining order of operations are supported.

Working with symbols

Placing symbols
To place a symbol in your schematic, use the  button or the  hotkey. The Choose Symbols dialog

appears and lets you select a symbol to add. Symbols are grouped by symbol library.

Cmd Ctrl

Ctrl

Shift

E

A
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By default, only the symbol/library name and description columns are shown. Additional columns can be
added by right-clicking the column header and selecting Select Columns.

The Choose Symbol dialog filters symbols by name, keywords, description, and all additional symbol fields

according to what you type into the search field.

Some advanced filters are available:

Wildcards: use the characters ?  and *  respectively to mean "any
single character or no characters" and

"any number of any characters,
including none".

Key-value pairs: if a library part’s description or keywords contain a tag
of the format "Key:123", you can

match relative to that by typing
"Key>123" (greater than), "Key<123" (less than), etc. Numbers may include
one of the following case-insensitive suffixes:

p n u m k meg g t

10 10 10 10 10 10 10 10

ki mi gi ti

2 2 2 2

Regular expressions: if you’re familiar with regular expressions, these
 can be used too. The regular

expression flavor used is the
wxWidgets
Advanced Regular Expression style, which is similar to Perl
regular
expressions.

-12 -9 -6 -3 3 6 9 12

10 20 30 40

http://docs.wxwidgets.org/3.0/overview_resyntax.html
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If the symbol specifies a default footprint, this footprint will be previewed in the lower right. If the symbol
includes footprint filters, alternate footprints that satisfy the footprint filters can be selected in the

footprint dropdown menu at right.

After selecting a symbol to place, the symbol will be attached to the cursor. Left clicking the desired location
in the schematic places the symbol into the schematic. Before placing the symbol in the schematic, you can
rotate it, mirror it, and edit its fields, by either using the hotkeys or the right-click context menu. These

actions can also be performed after placement.

If the Place repeated copies option is checked, after placing a symbol KiCad will start placing another copy
of the symbol. This process continues until the user presses .

For symbols with multiple units, if the Place all units option is checked, after placing the symbol KiCad will

start placing the next unit in the symbol. This continues until the last unit has been placed or the user
presses .

Placing power symbols
A power symbol is a symbol representing a connection to a power net. The symbols are grouped in the
power  library, so they can be placed using the symbol chooser. However, as power placements are frequent,

the  tool is available. This tool is similar, except that the search is done directly in the power  library and

any other library that contains power symbols.

Moving symbols
Symbols can be moved using the Move ( ) or Drag ( ) tools. These tools act on the selected symbol, or if
no symbol is selected they act on the symbol under the cursor.

The Move tool moves the symbol itself without maintaining wired connections to the symbol pins.

The Drag tool moves the symbol without breaking wired connections to its pins, and therefore moves the
connected wires as well.

You can also Drag symbols by clicking and dragging them with the mouse, depending on the Left button
drag gesture setting in the Mouse and Touchpad section of Preferences.

Symbols can also be rotated ( ) or mirrored in the X ( ) or Y ( ) directions.

Editing symbol properties
A symbol’s fields can be edited in the symbol’s Properties window. Open the Symbol Properties window for a
symbol with the  hotkey or by double-clicking on the symbol.

Esc

Esc

M G

R X Y

E
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The Symbol Properties window displays all the fields of a symbol in a table. New fields can be added, and

existing fields can be deleted, edited, reordered, moved, or resized.

Each field’s name and value can be visible or hidden, and there are several formatting options: horizontal
and vertical alignment, orientation, position, font, text color, text size, and bold/italic emphasis. Field
autoplacement can also be enabled on a per-field basis. The displayed position is always indicated for a

normally displayed symbol (no rotation or mirroring) and is relative to the anchor point of the symbol.

NOTE
Formatting options for symbol fields can be shown or hidden by
 right-clicking on the
header row of the symbol field table and enabling or
disabling the desired columns. Not
all columns are shown by default.

The Update Symbol from Library…​ button is used to update the schematic’s copy of the symbol to match

the copy in the library. The Change Symbol…​ button is used to swap the current symbol to a different
symbol in the library.

Edit Symbol…​ opens the Symbol Editor to edit the copy of the symbol in
 the schematic. Note that the

original symbol in the library will not be
modified. The Edit Library Symbol…​ button opens the Symbol
Editor to
edit the original symbol in the library. In this case, the symbol in the
schematic will not be modified
until the user clicks the Update Symbol from
Library…​ button.

Symbols have several attributes that affect how the symbols are treated by other parts of KiCad.

Exclude from simulation prevents the symbol from being included in SPICE
simulations.

Exclude from bill of materials prevents the component from being included in
BOM exports.

Exclude from board means that the symbol is schematic-only, and a
corresponding footprint will not be
added to the PCB.

Do not populate means that the component should not be attached to the PCB,
although a corresponding
footprint should still be added to the board. DNP
symbols appear desaturated and with a red "X" over them
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in the schematic, as
shown below.

Editing symbol fields individually
An individual symbol text field can be edited directly with the  hotkey (with a field selected instead of a

symbol) or by double-clicking on the field.

Some symbol fields have their own hotkey to edit them directly. With the symbol selected, the Reference,
Value, and Footprint fields can be edited with the , , or  hotkeys, respectively.

E

U V F
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The options in this dialog are the same as those in the full Symbol Properties dialog, but are specific to a
single field.

Symbol fields can be automatically moved to an appropriate location with the Autoplace Fields action (select
a symbol and press ). Field autoplacement is configurable in the Schematic Editor’s Editing Options,

including a setting to always autoplace fields.

Symbol Fields Table
The Symbol Fields Table allows you to view and modify field values for all symbols in a spreadsheet

interface. You can open the Symbol Fields Table with the  button.

Cells are navigated with the arrow keys, or with  / +  to move right / left and  / +
 to move down / up, respectively.

A range of cells can be selected by clicking and dragging. The whole range of selected cells will be copied (
+ ) or pasted into ( + ) on a copy or paste action. Copying a range of cells from the table can be

useful for creating a BOM. More details of copying and pasting cells are described below.

O

Tab Shift Tab Enter Shift

Enter

Ctrl C Ctrl V
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Any symbol field can be shown or hidden using the Show checkboxes on the left, or by right-clicking on the
header of the table. New symbol fields can be added using the Add Field…​ button.

Similar symbols can optionally be grouped by any symbol field using the Group By checkboxes. Grouped
symbols are shown in a single row in the table. The grouped row can be expanded to show the individual
symbols by clicking the arrow at the left of the row. The Group Symbols checkbox enables or disables
symbol grouping, and the  button recalculates groupings.

Symbols can be filtered using the Filter textbox at the top. The filter supports wildcards: *  matches any
number of any characters, and ?  matches any single character.

You can use the Export as CSV…​ button to save the symbol fields to an external file. This can be used as a
simple BOM generation tool, although the BOM tool provides better control over the generated output.

Tricks to simplify filling fields
There are several special copy/paste methods in the spreadsheet for pasting values into larger regions,
including auto-incrementing pasted cells. These features may be useful when pasting values that are shared

in several symbols.

These methods are illustrated below.



17

1. Copy ( + ) 2. Select target cells 3. Paste ( + )

NOTE These techniques are also available in other dialogs with a grid control element.

Reference Designators and Symbol Annotation
Reference designators are unique identifiers for components in a design. They are often printed on a PCB

and in assembly diagrams, and allow you to match symbols in a schematic to the corresponding components
on a board.

In KiCad, reference designators consist of a letter indicating the type of component ( R  for resistor, C  for
capacitor, U  for IC, etc.) followed by a number. If the symbol has multiple units then the reference

Ctrl C Ctrl V
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designator will also have a trailing letter indicating the unit. Symbols that don’t have a reference designator
set have a ?  character instead of the number. Reference designators must be unique.

Reference designators can be automatically set when symbols are added to the schematic, and you can set or
reset reference designators yourself by manually editing an individual symbol’s reference designator field or
in bulk using the Annotation tool.

NOTE The process of setting a symbol’s reference designator is called annotation.

Auto-annotation
When auto-annotation is enabled, symbols will be automatically annotated when they are added to the
schematic. You can enable auto-annotation by checking the Automatically annotate symbols checkbox in
the Schematic Editor → Annotation Options pane in Preferences. Auto-annotation can also be toggled

using the  button in the left toolbar.

When multiple symbols are added simultaneously, they are annotated according to the Order setting, sorted

by either X or Y position.

The Numbering option sets the starting number for new reference designators. This can be the lowest
available number, or a number based on the sheet number.

For more information about annotation options, see the documentation for the Annotation tool.

Alat Anotasi
The Annotation tool automatically assigns reference designators to symbols in the schematic. To launch the
Annotation tool, click the  button in the top toolbar.
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The tool provides several options to control how symbols are annotated.

Scope: Selects whether annotation is applied to the entire schematic, to only
the current sheet, or to only the
selected symbols. If the
 Recurse into subsheets option is selected, symbols in subsheets of the
 selected
scope will be reannotated; otherwise symbols in subsheets will not be
reannotated. For example, if Recurse
into subsheets and Selection only
selected, symbols in any selected subsheets will be reannotated.

Options: Selects whether annotation should apply to all symbols and reset
*existing reference designators,
or apply only to unannotated symbols.

Order: Chooses the direction of numbering. If symbols are sorted by X
position, all symbols on the left side

of a schematic sheet will be lower
numbered than symbols on the right side of the sheet. If symbols are
sorted by Y
position, all symbols on the top of a sheet will be lower numbered than symbols
at the bottom of
the sheet.

Numbering: Selects the starting point for numbering reference designators. The
 lowest unused number

above the starting point is picked for each reference
 designator. The starting point can be an arbitrary
number (typically zero), or
it can be the sheet number multiplied by 100 or 1000 so that each part’s
reference
designator corresponds to the schematic page it is on.

The Clear Annotation button clears all reference designators in the selected scope.

Annotation messages can be filtered with the checkboxes at the bottom or saved to a report using the
Save…​ button.
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Electrical Connections
There are two primary ways to establish connections: wires and labels. Wires make direct connections,
while labels connect to other labels with the same name. Both wires and labels are shown in the schematic

below.

Connections can also be made with buses and with implicit connections via hidden power pins.

This section will also discuss two special types of symbols that can be added with the "Power symbol" button
on the right toolbar:

Power symbols: symbols for connecting wires to a power or ground net.

PWR_FLAG: a specific symbol for indicating that a net is powered when it is
not connected to a power
output pin (for example, a power net that is supplied
by an off-board connector).

Wires
Wires are used to directly establish electrical connections between two points. To establish a connection, a
segment of wire must be connected by its end to another segment or to a pin. Only wire ends create

connections; if a wire crosses the middle of another wire, a connection will not be made.

Unconnected wire ends have a small square that indicates the connection point. The square disappears when
a connection is made to the wire end. Unconnected pins have a circle, which also disappears when a
connection is made.
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NOTE

Wires connect with other wires or pins only if their ends coincide
exactly. Therefore it is
important to keep symbol pins and wires aligned
to the grid. It is recommended to always
use a 50 mil grid when placing
symbols and drawing wires because the KiCad standard
symbol library and
all libraries that follow its style also use a 50 mil grid.

NOTE Symbols, wires, and other elements that are not aligned to the grid can be
snapped back to
the grid by selecting them, right clicking, and selecting
Align Elements to Grid.

Drawing and editing wires
To begin connecting elements with wire, use the Wire tool  in the right toolbar ( ). Wires can also be

automatically started by clicking on an unconnected symbol pin or wire end.

You can restrict wires to 90 degree angles using the  button in the left toolbar, or to 45 degree angles with

the  button. The  button allows you to place wires at any angle. You can cycle through these modes

using + , or select the desired mode in Preferences → Schematic Editor → Editing Options.
These modes affect graphic lines in addition to wires.

As in the PCB editor, the  hotkey switches wire posture.

Wires can be moved and edited using the Move ( ) or Drag ( ) tools. As with symbols, the Move tool
moves only the selected segment, without maintaining existing connections to other segments. The Drag
tool maintains existing connections.

You can select connected wires using the Select Connection tool ( + ). This tool selects all connected

wire segments until it reaches a junction, starting with the selected segment or the segment under the
cursor. Using the tool again expands the existing selection to the next junction.

You can break a wire segment into two pieces by right-clicking a wire and selecting Slice. The segment will
be separated at the current mouse position. You can also separate a wire segment from the adjacent

segments by right-clicking the segment and selecting Break.

Normally the line style of a wire follows the net’s netclass settings (nets are in the Default  netclass if no
other netclass is specified). However, the line style for the selected wire segments can be overridden in the

wire’s properties dialog (  when a wire segment is selected). The wire’s width, color, and line style (solid,
dashed, dotted, etc.) can be set. Setting the width to 0 , clearing the color, and using the Default  line style
uses the default width, color, and style, respectively, from the netclass settings. If a wire junction is included
in the selection, the junction size can also be edited here.

w

Shift Space

/

M G

Alt 4

E

file:///home/seth/code/kicad/kicad-doc/build/src/eeschema/pcbnew/pcbnew.html#track-posture
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Wire Junctions
Wires that cross are not implicitly connected. It is necessary to join them by explicitly adding a junction dot

if a connection is desired (  button in the right toolbar). Junction dots will be automatically added to

wires that start or end on top of an existing wire.

Junction dots are used in the schematic figure above on the wires connected to P1  pins 18, 19, 20, 21, 22, and
23.

Junction size automatically follows the schematic’s Junction dot size setting in Schematic Setup → General
→ Formatting. Color follows the netclass setting. The automatic size and color can be overridden in each
junction dot’s properties; a size of 0  is equivalent to the schematic default size, and clearing the color uses
the netclass color.
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Labels
Labels are used to assign net names to wires and pins. Wires with the same net name are considered to be

connected, so labels can be used to make connections without drawing direct wire connections.

A net can only have one name. If two different labels are placed on the same net, an ERC violation will be
generated. Only one of the net names will be used in the netlist. The final net name is determined according
to the rules described below.

There are three types of labels, each with a different connection scope.

Local labels, also referred to simply as labels, only make connections
within a sheet. Add a local label

with the
  button in the right
toolbar.

Global labels make connections anywhere in a schematic, regardless of sheet.
Add a global label with the

 button in the right
toolbar.

Hierarchical labels connect to hierarchical sheet pins and are used in
 hierarchical schematics for

connecting child
sheets to their parent sheet. Add a hierarchical label with the
 
button in the right

toolbar.

NOTE Labels that have the same name will connect, regardless of the label type,
if they are in the
same sheet.

Adding and editing labels
After using the appropriate button or hotkey to create a label, the Label Properties dialog appears.
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The Label field sets the label’s text, which determines the net that the label assigns to its attached wire.

Label text supports markup for overbars, subscripts, etc., as well as variable substitution. Use the Syntax
help link in the dialog for a summary.

There are several options to control the label’s appearance. You can change the font, size, and color of the
text, and set bold and italic emphasis. You can also set the orientation of the text relative to the label’s

connection point. Hierarchical and global labels have several additional options: the Auto option
automatically sets the label orientation based on the connected schematic elements, and Shape option
controls the shape of the label outline (Input, Output, Bidirectional, Tri-state, or Passive). The outline
shape is purely visual and has no electrical consequence.

NOTE The default text size can be set for a schematic in
Schematic Setup, and the default font
can
be set in Preferences.

NOTE Global labels have additional settings to control margins around the label
 text in the
Schematic Setup dialog.

Labels can also have fields added to them. Two fields have special meaning ( Net Class  and Sheet
References , described below), but arbitrary fields can also be added. Label fields behave like symbol fields:
you can show or hide their name and value and adjust the alignment, orientation, position, size, font, color,

and emphasis.

NOTE
Formatting options for label fields can be shown or hidden by
right-clicking on the header
row of the label field table and enabling or
disabling the desired columns. Not all columns
are shown by default.

Like symbol fields, label fields can be edited individually by opening the properties of a specific label field

from the schematic (double click the label field, or use ).

After accepting the label properties, the label is attached to the cursor for placement. The connection point
for a label is the small square in the corner of the label. The square disappears when the label is connected to

E
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a wire or the end of a pin.

The connection point’s position relative to the label text can be changed by choosing a different label
orientation in the label’s properties, or by mirroring/rotating the label.

The Label Properties dialog can be accessed at any time by selecting a label and using the  hotkey, double-

clicking on the label, or with Properties…​ in the right-click context menu.

Assigning net classes with labels
In addition to assigning net names, labels can be used to assign net classes. A label field named Net Class

assigns the specified netclass to the net associated with the label. To make it easier to assign net classes in
this way, Net Class  is the default name for new label fields, and Net Class  fields present a dropdown list
of all the net classes in the design. Net classes must be created in the Schematic Setup or Board Setup
windows before they can be assigned with a label field.

For more information about assigning netclasses, see the netclass documentation.

Inter-sheet references
Global labels can display inter-sheet references, which are a list of page numbers for other places in the
schematic where the same global label appears. Clicking an inter-sheet reference travels to the listed page. If
multiple references are listed, clicking the reference list brings up a menu to select the desired page.

Inter-sheet references are globally controlled in the Schematic Setup window’s Formatting page. References

can be enabled or disabled, and the displayed format for the list can be adjusted, including with optional
prefix or suffix characters.

The image below shows a global label with inter-sheet references to two other schematic pages. A prefix and
suffix of [  and ] , respectively, were added in Schematic Setup.

E

file:///home/seth/code/kicad/kicad-doc/build/src/eeschema/pcbnew/pcbnew.html#board-setup-net-classes
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A Sheet References  field with value ${INTERSHEET_REFS}  is automatically added to global labels, and is
used to control the appearance of inter-sheet references for that label. The ${INTERSHEET_REFS}  text

variable gets expanded to the full list of inter-sheet references for the global label, as configured in
Schematic Setup. Visibility of inter-sheet references is globally controlled in Schematic Setup rather than
with the Sheet References  field visibility control. The Sheet References  field has no meaning for other
types of labels.

Buses
Buses are a way to group related signals in the schematic in order to simplify complicated designs. Buses can
be drawn like wires using the bus tool , and are named using labels the same way signal wires are.

In the following schematic, many pins are connected to buses, which are the thick blue lines in the center.

Anggota Bus
There are two types of bus in KiCad 6.0 and later: vector buses and group buses.

A vector bus is a collection of signals that start with a common prefix and end with a number. Vector buses

are named <PREFIX>[M..N]  where PREFIX  is any valid signal name, M  is the first suffix number, and N  is
the last suffix number. For example, the bus DATA[0..7]  contains the signals DATA0 , DATA1 , and so on up to
DATA7 . It doesn’t matter which order M  and N  are specified in, but both must be non-negative.
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A group bus is a collection of one or more signals and/or vector buses. Group buses can be used to bundle
together related signals even when they have different names. Group buses use a special label syntax:

<OPTIONAL_NAME>{SIGNAL1 SIGNAL2 SIGNAL3}

The members of the group are listed inside curly braces ( {} ) separated by space characters. An optional
name for the group goes before the opening curly brace. If the group bus is unnamed, the resulting nets on
the PCB will just be the signal names inside the group. If the group bus has a name, the resulting nets will

have the name as a prefix, with a period ( . ) separating the prefix from the signal name.

For example, the bus {SCL SDA}  has two signal members, and in the netlist these signals will be SCL  and
SDA . The bus USB1{DP DM}  will generate nets called USB1.DP  and USB1.DM . For designs with larger buses
that are repeated across several similar circuits, using this technique can save time.

Group buses can also contain vector buses. For example, the bus MEMORY{A[7..0] D[7..0] OE WE}  contains
both vector buses and plain signals, and will result in nets such as MEMORY.A7  and MEMORY.OE  on the PCB.

Bus wires can be drawn and connected in the same manner as signal wires, including using junctions to
create connections between crossing wires. Like signals, buses cannot have more than one name — if two

conflicting labels are attached to the same bus, an ERC violation will be generated.

Koneksi Antar Anggota Bus
Pins connected between the same members of a bus must be connected by labels. It is not possible to
connect a pin directly to a bus; this type of connection will be ignored by KiCad.

Pada contoh di atas, koneksi dibuat dengan menggunakan label yang diletakkan pada wire yang terhubung
ke pin. Jalur masuk bus (wire dengan sudut 45 derajat) hanya bersifat grafis, dan tidak diperlukan untuk

membuat koneksi logis.

In fact, using the repetition command ( ), connections can be very quickly made in the following way,
if component pins are aligned in increasing order (a common case in practice on components such as
memories, microprocessors…​):

Place the first label (for example PCA0 )

Use the repetition command as much as needed to place members. KiCad will automatically create the

next labels ( PCA1 , PCA2…​) vertically aligned, theoretically on the position of the other pins.

Tariklah wire di bawah label pertama. Lalu gunakan perintah repetisi untuk meletakkan wire berikutnya

di bawah label yang sudah dibuat.

Jika diperlukan, letakkan jalur masuk bus dengan cara yang sama (Letakkan jalur masuk yang pertama,

lalu gunakan perintah repetisi).

NOTE

In the Schematic Editor → Editing Options section of the Preferences menu, you can set

the repetition parameters:

Horizontal pitch

Vertical pitch

Label increment (labels can be incremented or decremented by 1, 2, 3, etc.)

Insert
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Bus unfolding
The unfold tool allows you to quickly break out signals from a bus. To unfold a signal, right-click on a bus
object (a bus wire, etc) and choose Unfold from Bus. Alternatively, use the Unfold Bus hotkey (default: )

when the cursor is over a bus object. The menu allows you to select which bus member to unfold.

After selecting the bus member, the next click will place the bus member label at the desired location. The
tool automatically generates a bus entry and wire leading up to the label location. After placing the label, you
can continue placing additional wire segments (for example, to connect to a component pin) and complete

the wire in any of the normal ways.

Bus aliases
Bus aliases are shortcuts that allow you to work with large group buses more efficiently. They allow you to
define a group bus and give it a short name that can then be used instead of the full group name across the
schematic.

To create bus aliases, open the Bus Alias Definitions pane in Schematic Setup.

An alias may be named any valid signal name. Using the dialog, you can add signals or vector buses to the
alias. As a shortcut, you can type or paste in a list of signals and/or buses separated by spaces, and they will

all be added to the alias definition. In this example, we define an alias called USB  with members DP , DM , and
VBUS .

After defining an alias, it can be used in a group bus label by putting the alias name inside the curly braces of

the group bus: {USB} . This has the same effect as labeling the bus {DP DM VBUS} . You can also add a prefix
name to the group, such as USB1{USB} , which results in nets such as USB1.DP  as described above. For
complicated buses, using aliases can make the labels on your schematic much shorter. Keep in mind that the
aliases are just a shortcut, and the name of the alias is not included in the netlist.

C
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Bus aliases are saved in the schematic file that is opened when the alias is created. The Bus Alias
Definitions window shows the schematic file associated with the selected alias at the bottom of the alias

list. Any aliases created in a given schematic sheet are available to use in any other schematic sheet that is in
the same hierarchical design. If multiple sheets in a hierarchical design contain identically-named bus aliases,
the aliases must all have the same members. ERC will report a violation if multiple bus aliases with the same
name do not have consistent members.

Buses with more than one label
KiCad 5.0 and earlier allowed the connection of bus wires with different labels together, and would join the
members of these buses during netlisting. This behavior has been removed in KiCad 6.0 because it is

incompatible with group buses, and also leads to confusing netlists because the name that a given signal will
receive is not easily predicted.

If you open a design that made use of this feature in a modern version of KiCad, you will see the Migrate
Buses dialog which guides you through updating the schematic so that only one label exists on any given set

of bus wires.

For each set of bus wires that has more than one label, you must choose the label to keep. The drop-down
name box lets you choose between the labels that exist in the design, or you can choose a different name by
manually entering it into the new name field.

Hidden Power Pins
When the power pins of a symbol are visible, they must be connected, as with any other signal. However,
symbols such as gates and flip-flops are sometimes drawn with hidden power input pins which are

connected implicitly.

KiCad automatically connects invisible pins with type "power input" to a global net with the same name as
the pin. For example, if a symbol has a hidden power input pin named VCC , this pin will be globally

connected to the VCC  net on all sheets.
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NOTE
Hidden pins can be shown in the schematic by checking the Show hidden
pins option in
the Schematic Editor → Display Options section
of the preferences, or by selecting View
→ Show hidden pins.
There is also a toggle icon  on the
left toolbar.

It may be necessary to join power nets of different names (for example, GND  in TTL components and VSS  in
MOS components). To accomplish this, add a power symbol for each net and connect them with a wire.

If hidden power pins are used, it is not recommended to use local labels for power connection, as they will
not connect to hidden power pins on other sheets.

NOTE

Care must be taken with hidden power input pins because they can create
unintentional
connections. By nature, hidden pins are invisible and do not
display their pin name. This
makes it easy to accidentally connect two
power pins to the same net. For this reason,
using invisible power pins
in symbols is not recommended outside of power symbols,
and is only
supported for compatibility with legacy designs and symbols.

Simbol Power
Power symbols are symbols that are conventionally used to represent a connection to a power net, such as
VCC  or GND . In addition to being a visual indicator that the attached net is a power rail, power symbols

make global connections: two power symbols with the same pin name connect to each other anywhere in
the schematic, regardless of sheet.

In the figure below, power symbols are used to connect the positive and negative terminals of the capacitors
to the VCC  and GND  nets, respectively.

In the KiCad standard library, power symbols are found in the power  library, but power symbols can be
created in any library. To create a custom power symbol, make a new symbol with a power input pin that is

set to be invisible. Name the pin according to the desired power net. In addition, set the "Define as power
symbol" symbol property. As described in the hidden power pins section, invisible power input pins make
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global connections based on the hidden power pin’s name. The process of creating a power symbol is
described in more detail in the Symbol Editor section.

NOTE
The connected net name is determined by the power symbol’s pin name, not
the name or
value of the symbol. This means that power symbol net names
can only be changed in the
symbol editor, not in the schematic.

Net name assignment rules
Every net in the schematic is assigned a name, whether that name is specified by the user or automatically
generated by KiCad.

When multiple labels are attached to the same net, the final net name is determined in the following order,

from highest priority to lowest:

1. Label Global

2. Power symbols

3. Local labels

4. Label Hirarkis

5. Hierarchical sheet pins

If there are multiple labels of one type attached to a net, the names are sorted alphabetically and the first is
used.

If a net travels through multiple sheets of a hierarchy, it will take its name from the highest level of the

hierarchy where it has a hierarchical label or local label. As usual, local labels take priority over hierarchical
labels.

If none of the label types above are attached to a net, the net’s name is automatically generated based on the
connected symbol pins.

PWR_FLAG
Two PWR_FLAG  symbols are visible in the screenshot above. They indicate to ERC that the two power nets

VCC  and GND  are actually connected to a power source, as there is no explicit power source such as a
voltage regulator output attached to either net.

Without these two flags, the ERC tool would diagnose: Error: Input Power pin not driven by any Output

Power pins.

The PWR_FLAG  symbol is found in the power  symbol library. The same effect can be achieved by connecting
any power output pin to the net.

No-connection flag
No-connection flags ( ) are used to indicate that a pin is intentionally unconnected. These flags do not

have any effect on the schematic’s connectivity, but they prevent "unconnected pin" ERC warnings for pins

that are intentionally unconnected.
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Netclasses
Netclasses are groups of nets that can be assigned design rules (for the PCB) and graphical properties (for
the schematic). In KiCad, each net is part of exactly one net class. If you do not add a net to a specific class, it

will be part of the Default class, which always exists.

Net classes may be created and edited in either the Schematic or Board Setup dialogs. Nets can be added to
netclasses in either the schematic or board using pattern-based assignments described below. Nets can also
be assigned to netclasses in the schematic using graphical assignments with net class directives or net labels.

Selecting a wire or label displays the net’s netclass in the message panel at the bottom of the window.

Managing netclasses in Schematic Setup
Netclasses are managed in the Net Classes panel of the Schematic Setup dialog.
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The top pane lists the netclasses that exist in the design. The Default  netclass always exists, and you can

add additional netclasses with the  button or remove the selected netclass with the  button.

Each netclass can have unique graphic properties that determine how wires of that netclass are displayed in
the schematic. Wire and bus thicknesses, color, and line style (solid, dashed, dotted, etc.) can all be adjusted.
Setting the color to transparent will use the theme’s default wire/bus color for the netclass, which is

configurable in Preferences.

You can also set board design rules for each netclass, although the DRC fields are hidden by default. Right
click the header row to show or hide additional columns. For more information about setting netclass design
rules, see the PCB editor documentation.

The bottom pane lists pattern-based netclass assignments. Each row has a net name pattern and a netclass;
nets with names that match the pattern are assigned to the specified netclass. If a net matches multiple
patterns, the first match is used. Pattern-based netclass assignments are dynamic: when a new net is added

that matches an existing pattern, it will be assigned to the associated netclass automatically. Net patterns can
use both regular expressions and wildcards ( *  to match any number of any characters, including none, and
?  to match zero or one of any character). The nets that match the selected pattern are displayed to the right
of the pattern list.

NOTE
Remember that net names must include the full sheet path. For example, a
locally labeled
net in the root sheet has a name prefixed with / .

Use the  button to add a net class assignment pattern or the  button to remove a pattern.

NOTE Only named nets can be assigned to a netclass with a pattern. To assign a
netclass to an
unnamed net, use a net class
directive.

file:///home/seth/code/kicad/kicad-doc/build/src/eeschema/pcbnew/pcbnew.html#board-setup-net-classes
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Instead of adding netclass patterns in the Schematic Setup dialog, you can directly create netclass patterns
from the schematic canvas. Right click a net and select Assign Netclass…​ to bring up the Add Netclass
Assignment dialog. The netclass pattern is pre-filled with the name of the selected net, but the pattern can
be changed if desired. All nets matching the pattern are displayed in the dialog.

Graphically assigning netclasses in the schematic
As an alternative to pattern-based netclass assignment, netclasses can be graphically assigned to nets in the
schematic using either net class directives or labels. Netclasses must be created in Schematic Setup before
they can be assigned graphically.

In the image below, a net class directive is used to assign signals to the 50R  netclass.
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Net class directives are added with the  button in the right toolbar. They behave like labels, except that

they cannot be used to name a net. The attached net is assigned a netclass according to the value of the
directive’s Net Class  field. The Net Class  field presents a dropdown list of all the net classes in the design.

If a directive is attached to a bus, all members of the bus are assigned to the specified net class.

In addition to the associated netclass, you can edit the directive’s shape (dot, circle, diamond, or rectangle),

orientation, pin length, and color in the directive’s properties.

Net labels can also be used to assign netclasses to nets by adding a Net Class  field to the label.

If more than one different netclass is graphically assigned to a single net, ERC will report an issue. Graphical
netclass assignments override pattern-based assignments: if a net matches a netclass pattern assignment
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and also has a netclass assigned graphically, the graphically assigned netclass will be used.

Graphical items
Text, graphic shapes, and images can be added to schematics for documentation purposes. These items do

not have any electrical effect on the schematic.

The image below shows graphic lines and text ("COMMUNICATION DSP") in addition to symbols and several
types of labels.

Text and Text Boxes
Two kinds of text can be added to schematics, which are referred to as text ( ) and text boxes ( ). Both

are added using their respective buttons in the right toolbar.

Both kinds of text item support multiline text and basic formatting features, but text boxes wrap text to fit

in the outline and have additional formatting options. All text has adjustable fonts, color, size, bold and italic
emphasis, left and right alignment, and vertical and horizontal orientation. Text boxes additionally support
horizontal centering, vertical alignment options, and colored borders and fill.

NOTE The default text size can be set for a schematic in
Schematic Setup, and the default font
can
be set in Preferences.
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Links
Text and text boxes can be made into a link by entering a target in the Link box in the text properties. The
link target can be a local file (using the file://  protocol prefix followed by the file’s path), to a website

(using http://  or https://  followed by the rest of the URL), or to another page in the same schematic
(using #  followed by the page number). These can also be autofilled using the dropdown menu in the link
target box.

Fonts
Text and text boxes support custom fonts, which are selectable with the Font dropdown in the properties
dialog for the text. In addition to the KiCad font, you can use any TTF font installed on your computer.

NOTE
User fonts are not embedded in the project. If the project is opened on another computer
that does not have the selected font installed, a different font will be substituted. For
maximum compatibility, use the KiCad font.

Text Markup
Text supports markup for superscripts, subscripts, overbars, evaluating project variables, and accessing

symbol field values.
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Feature Markup Syntax Result

Superscript text^{superscript} text

Subscript text_{subscript} text

Overbar ~{text} text

Variables ${variable} variable_value

Symbol Fields ${refdes:field} field_value of symbol refdes

NOTE Variables must be defined in
Schematic Setup before they can be
used. There are also a
number of
built-in system text variables.

Graphic Shapes
Graphic rectangles ( ), circles ( ), arcs ( ), and lines ( ) can all be added using their respective

buttons in the right toolbar.

Line width, color, and style (solid, dashed, or dotted) can be configured in the properties dialog for each
shape ( ). Rectangles, circles, and arcs can also have a fill color set and have their outlines removed.

superscript

subscript

E
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Setting a shape’s line width to 0 uses the schematic default line width, which is configurable in Schematic
Setup. Spacing for line dashes is also configurable there. Removing a line or fill color uses the color theme’s
graphics color, which is configurable in Preferences.

Like wires, graphic lines obey the line drawing mode setting (90 degree, 45 degree, or free angle), which you

can set using the toggle buttons on the left toolbar ( , , and , respectively). +  cycles

through the modes.

As with PCB tracks, the  hotkey switches line posture.

Bitmap Images
Bitmap images can be added to the schematic with the  button. Images in the schematic can be moved

and scaled. The properties dialog allows setting a location and scale as well as converting the image to
greyscale.

Bulk editing text and graphics
Properties of text and graphics can be edited in bulk using the Edit Text and Graphic Properties dialog

(Tools → Edit Text and Graphic Properties…​). The tool can also modify visual properties of wires and
buses.

Shift Space

/

file:///home/seth/code/kicad/kicad-doc/build/src/eeschema/pcbnew/pcbnew.html#track-posture
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Scope and Filters
Scope settings restrict the tool to editing only certain types of objects. If
no scopes are selected, nothing will

be edited.

Filters restrict the tool to editing particular objects in the selected scope.
Objects will only be modified if
they match all enabled and relevant filters
 (some filters do not apply to certain types of objects. For

example, symbol
 field filters do not apply to wires and are ignored for the purpose of changing
 wire
properties). If no filters are enabled, all objects in the selected scope
will be modified. For filters with a text
box, wildcards are supported: * 
matches any characters, and ?  matches any single character.

Filter fields by name filters to the specified symbol, label, or sheet field.

Filter items by parent reference designator filters to fields in the
 symbol with the specified reference
designator. Filter items by parent symbol
library id filters to fields in symbols with the specified library
identifier.
Filter items by parent symbol type filters to fields in symbols of the
selected type (power or
non-power).

Filter items by net filters to wires and labels on the specified net.
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Only include selected items filters to the current selection.

Editable Properties
Properties for filtered objects can be set to new values in the bottom part of the dialog.

Drop-down lists and text boxes can be set to -- leave unchanged --  to preserve existing values.
Checkboxes can be checked or unchecked to enable or disable a change, but can also be toggled to a third

"leave unchanged" state. Color properties must be checked to change the value; a checkerboard swatch
indicates that the color will be inherited from the default value from the the schematic settings or netclass
properties.

Text properties that can be modified are font, text size, text orientation (right/up/leftdown), horizontal
and vertical alignment, text color, emphasis (bold and italic), and visibility of fields and field names.

Graphic and wire properties that can be modified are line width, line style (solid, dashed, and dotted lines),
line color, fill color for shapes, and junction size and junction color for wire junctions.

Blok Judul pada Lembar Kerja
The title block is edited with the Page Settings tool ( ).

Each field in the title block can be edited, as well as the paper size and orientation. If the Export to other
sheets option is checked for a field, that field will be updated in the title block of all sheets, rather than only
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the current sheet.

You can set the date to today’s or any other date by pressing the left arrow button next to Issue Date. Note

that the date in the schematic will not be automatically updated.

A drawing sheet template file can also be selected.

The sheet number (Sheet X/Y) is automatically updated, but sheet page numbers can also be manually set

using Edit → Edit Sheet Page Number…​.

Schematic Setup
The Schematic Setup window is used to set schematic options that are specific to the currently active
schematic. For example, the Schematic Setup window contains formatting options, electrical rule
configuration, netclass setup, and schematic text variable setup.

You can import schematic settings from an existing project using the Import Settings from Another
Project…​ button. This allows you to choose a project to use as a template and select which settings to import
(formatting preferences, field name templates, pin conflict map, violation severities, and net classes).
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Schematic formatting

The formatting panel contains settings for the appearance of symbols, text, labels, graphics, and wires.

Symbol unit notation sets how each unit of a multi-unit symbol is referred to
in its reference designator. By
default, a different letter for each unit is
 appended to the reference designator with no separator, for

example U1B  for
the second unit of symbol U1 , but this can be changed. Numbers can be used
instead of
letters, and various separators can be used between the symbol
designator and the unit identifier ( . , - , _ ,
or none).

Default text size sets the default text height used by the text, text box, and
label tools. Label offset ratio
controls the vertical spacing between a local
label’s text and the attached wire, relative to the label’s text
size. This also
affects the spacing between symbol pins and their pin number.
Global label margin defines
the size of the box around a global label,
relative to the global label’s text size. Increasing the margin may be

useful
to avoid overlapping text with overbars ( ~{} ) or letters with descenders, but
this may cause closely
packed global labels to overlap with each other.

Default line width sets the default line width for symbol graphics, if the
 symbol does not override the
default line width. Pin symbol size scales symbol
pin graphic style annotations, such as the bubble on an

inverted pin.

Junction dot size sets the schematic’s default wire junction dot size. The
default size can be overridden by
editing an individual junction dot’s
properties.

Show inter-sheet references enables or disables the display of
inter-sheet references, which are a list of

page
numbers next to a global labels that link to other places in the schematic where
the same global label
appears. Show own page reference controls whether the
 current page is included in the list of page
numbers. Standard and
abbreviated determine whether to display the complete list of page numbers or
only the first and last page numbers. The prefix and suffix fields add
optional characters before and after
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the list of page numbers. In the image
of an inter-sheet reference below, a prefix and suffix of [  and ] ,
respectively, have been added.

Dashed line appearance is controlled in the Formatting section. Dash length controls the length of dashes,
while Gap length controls the spacing between dashes and dots. The dash and gap lengths are relative to the

line width: a gap length of 2  means twice the width of the line.

Field name templates

Field name templates are empty symbol fields that are automatically added to all symbols in the schematic.
These can be useful when every symbol in the schematic needs additional fields beyond the fields that are

defined in the library symbols, for example a field for the manufacturer’s part number.

Template fields can be set as visible or invisible, and can also be set as URL fields.

Field name templates that are defined in schematic setup apply only to the current project. Field name
templates can also be defined in Preferences, which apply to all projects edited on your computer.
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ERC violation severity and pin conflicts map
The Violation Severity panel lets you configure what types of ERC messages should be reported as Errors,
Warnings, or ignored.

The Pin Conflicts Map allows you to configure connectivity rules to define electrical conditions for errors
and warnings based on what types of pins are connected to each other. For example, by default an error is
produced when an output pin is connected to another output pin.
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These panels are explained in more detail in the ERC section.

Net classes

The Net Classes panel allows you to manage netclasses for the project and assign nets to netclasses with
patterns. Managing netclasses in this panel is equivalent to managing them in the Board Setup dialog. Nets

can also be assigned to netclasses in the schematic using graphical assignments with net class directives or
net labels.

file:///home/seth/code/kicad/kicad-doc/build/src/eeschema/pcbnew/pcbnew.html#board-setup-net-classes
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Pattern-based netclass assigment is explained in more detail in the net classes section.

Bus alias definitions

The Bus Alias Definitions panel allows you to create bus aliases, which are names for groups of signals in a
bus. For more information about bus aliases, see the bus alias documentation.

Text variables
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Text replacement variables can be created in the Text Variables section. These variables allow you to
substitute the variable name for any text string. This substitution happens anywhere the variable name is

used inside the variable replacement syntax of ${VARIABLENAME} .

For example, you could create a variable named VERSION  and set the text substitution to 1.0 . Now, in any
text object on the PCB, you can enter ${VERSION}  and KiCad will substitute 1.0 . If you change the
substitution to 2.0 , every text object that includes ${VERSION}  will be updated automatically. You can also

mix regular text and variables. For example, you can create a text object with the text Version: ${VERSION}
which will be substituted as Version: 1.0 .

Text variables can also be created in Board Setup. Text variables are project-wide; variables created in the
schematic editor are also available in the board editor, and vice versa.

There are also a number of built-in system text variables.

Menyelamatkan tembolok simbol
By default, KiCad loads symbols from the project libraries according to the set paths and
library order. This
can cause a problem when loading a very old project: if the symbols in the
library have changed or have
been removed or the library no longer exists since they were used
in the project, the ones in the project

would be automatically replaced with the new versions.
The new versions might not line up correctly or
might be oriented differently leading to a
broken schematic.

When a project is saved, a cache library with the contents of the current library symbols is saved along with

the schematic. This allows the project to be distributed without the full libraries. If you load a project where
symbols are present both in its cache and in the system libraries, KiCad will scan the libraries for conflicts.
Any conflicts found will be listed in the following dialog:

file:///home/seth/code/kicad/kicad-doc/build/src/eeschema/pcbnew/pcbnew.html#board-setup-text-variables
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You can see in this example that the project originally used a diode with the cathode facing up, but the
library now contains one with the cathode facing down. This change would break the schematic! Pressing OK
here will cause the symbol cache library to be saved into a special rescue  library and all the symbols are
renamed to avoid naming conflicts.

If you press Cancel, no rescues will be made, so KiCad will load all the new components by default. If you
save the schematic at this point, your cache will be overwritten and the old symbols will not be recoverable.
If you have saved the schematic, you can still go back and run the rescue function again by selecting "Rescue
Cached Components" in the "Tools" menu to call up the rescue dialog again.

Jika Anda tidak ingin menampilkan kotak dialog ini, Anda bisa memilih tombol "'Never show Again'". Secara
default, Eeschema tidak akan melakukan apapun dan akan memuat seluruh komponen baru. Pilihan ini
dapat diubah kembali pada menu "'Preferences'".
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Skematik Hirarkis
Pengenalan
In KiCad, multi-sheet schematics are hierarchical: there is a single root sheet, and additional sheets are
created as subsheets of either the root sheet or another subsheet. Sheets can be included in a hierarchy
multiple times, if desired.

Carefully drawing a schematic as a hierarchical design improves schematic legibility and reduces repetitive

drawing.

Creating a hierarchical schematic starts from the root sheet. The process is to create a subsheet, then draw
the circuit in the subsheet and make the necessary electrical connections between sheets. Connections can be
made between nets in a subsheet and nets in the parent sheet using hierarchical pins and labels, or between

any two nets in the hierarchy using global labels.

Adding sheets to a design
You can add a subsheet to a design with the Add Hierarchical Sheet tool (  hotkey, or the  button in the

right toolbar). Launch the tool, then click twice in the canvas to draw the upper left and lower right corners
of the subsheet symbol. Make the sheet outline large enough to fit the hierarchical pins you will add later.

The Sheet Properties dialog will appear and prompt you for a sheet name and filename.

S
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The sheet name must be unique, as it is used in the full net name for any nets in the subsheet. For example, a
net with the local label net1  in the sheet sheet1  would have a full net name of /sheet1/net1 . The sheet
name is also used to refer to the sheet in various places in the GUI, including the title block and the hierarchy
navigator.

The sheet file specifies the file that the new sheet will be saved to or loaded from. The path to the sheet file
can be relative or absolute. It is usually preferable to save subsheet files in the project directory and use a
relative path so that the project is portable.

A single sheet file can be used more than once in a project by specifying the same filename for each repeated

sheet; the circuit drawn in the sheet will be instantiated once per usage, and any edits in once instance will
be reflected in the other instances.

NOTE
Sheet files can be shared between multiple projects to allow design reuse between
projects. However, this is not recommended due to path portability concerns and the risk
of unintentionally changing other projects while editing a shared sheet.

The sheet’s page number is configurable here. The page number is displayed in the sheet title block and the
hierarchy navigator, and sheets are sorted by page number in the hierarchy navigator and when printing or
plotting.

Several graphical options are also available. Border width sets the width of the border around the sheet
shape. Border color and Background fill set the color for the border and fill of the sheet shape,
respectively. If no color is set, a checkerboard swatch is shown and the default values from the color theme
are used.

Sheets support arbitrary custom fields, which can be added and removed with the  and  buttons,
respectively. Sheet fields can be optionally displayed on the schematic by checking their Show box, and they
can be accessed from inside the sheet or in other sheet fields using text variables.

The Sheet Properties dialog can be accessed at any time by selecting a sheet symbol and using the  hotkey,

or by right-clicking on a sheet symbol and selecting Properties…​.

Navigating between sheets
You can enter a hierarchical sheet from the parent sheet by double-clicking the child sheet’s shape, or right-
clicking the child sheet and selecting Enter Sheet.

E
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Return to the parent sheet by using the  button in the top toolbar, or by right-clicking in an empty part of

the schematic and clicking Leave Sheet.

You can jump to the next sheet with the  button, or to the previous sheet with the  button.

Alternatively, you can jump to any sheet with the hierarchy navigator. To open the hierarchy navigator, click

the  button in the left toolbar. The hierarchy navigator docks at the left of the screen. Each sheet in the

design is displayed as an item in the tree. Clicking a sheet name opens that sheet in the editing canvas.

Electrical connections between sheets

Label overview
Electrical connections between sheets are made with labels. There are several kinds of labels in KiCad, each
with a different connection scope.
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Local labels only make connections within a sheet. Therefore local
 labels cannot be used to connect

between sheets. Local labels are added with
the  button.

Global labels make connections anywhere in a schematic, regardless of sheet.
Global labels are added

with the
  button.

Hierarchical labels connect to hierarchical sheet pins accessible in the
 parent sheet. Hierarchical

designs rely on hierarchical labels and pins to
make connections between parent sheets and child sheets;
you can think of
hierarchical pins as defining the interface for a sheet. Hierarchical labels
are added with

the
 
button.

NOTE Labels that have the same name will connect, regardless of the label type,
if they are in the
same sheet.

NOTE Hidden power pins can also be considered global
labels, because they connect anywhere
in the schematic hierarchy.

Hierarchical sheet pins
After placing hierarchical labels within the subsheet, matching hierarchical pins can be added to the
subsheet symbol in the parent sheet. You can then make connections to the hierarchical pins with wires,
labels, and buses. Hierarchical pins in a subsheet symbol are connected to the matching hierarchical labels in

the subsheet itself.

NOTE Hierarchical labels must be defined in the subsheet before the
corresponding hierarchical
sheet pin can be imported in the sheet symbol.

For every hierarchical label in the subsheet, import the corresponding hierarchical pin into the sheet symbol

by clicking the  button in the right toolbar, then clicking on the sheet symbol. A sheet pin for the first
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unmatched hierarchical label will be attached to the cursor, where it can be placed anywhere along the
border of the sheet symbol. Clicking again with the tool will continue to import additional sheet pins until

there are no more hierarchical pins to import from the subsheet. Sheet pins can also be imported by
selecting Import Sheet Pin in a sheet symbol’s right-click context menu.

You can edit the properties of a sheet pin in the Sheet Pin Properties dialog. Open this dialog by double-
clicking a sheet pin, selecting a sheet pin and using the  hotkey, or right-clicking a sheet pin and selecting

Properties…​.

The sheet pin’s name can be edited in the textbox or by selecting from the dropdown list of hierarchical

labels in the subsheet. A sheet pin’s name has to match the corresponding hierarchical label in the subsheet,
so if a pin name is changed the label must change as well.

Shape changes the shape of the sheet pin, and has no electrical
 effect. It can be set to Input, Output,
Bidirectional, Tri-state, or Passive.
The pin’s font, text size, color, and emphasis (bold or italic) can also
be

changed.

Hierarchical design examples
Hierarchical designs can be put into one of several categories:

Simple: each sheet is used only once.

Complex: some sheets are instantiated multiple times.

Flat: a sub-case of a simple hierarchy, without connections between
 subsheets and their parent. Flat
hierarchies can be used to represent a
non-hierarchical design.

Each hierarchy model can be useful; the most appropriate one depends on the design.

Simple hierarchy
An example of a simple hierarchy is the video  demo project included with KiCad. The root sheet contains
seven unique subsheets, each with hierarchical labels and sheet pins linking the sheets to each other in the
root sheet. Two of the subsheet symbols are shown below.

E



55

Hirarki Kompleks
The complex_hierarchy  demo project is an example of a complex hierarchy. The root sheet contains two

subsheet symbols, which both refer to the same sheet file ( ampli_ht.kicad_sch ). This allows the design to
include two copies of the same amplifier circuit. Although the two sheet symbols refer to the same filename,
the sheet names are unique ( ampli_ht_vertical  and ampli_ht_horizontal ). Inside each subsheet the
circuits are identical except for the reference designators, which as always are unique.

This project contains no sheet pin connections. The only connections between the root sheet and the
subsheets are global power connections made with power symbols. However, sheets in a complex hierarchy
could include sheet pin connections if appropriate for the design.
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Hirarki Datar
The flat_hierarchy  demo project is an example of a flat hierarchy. The root sheet contains two unique

subsheet symbols with no hierarchical sheet pins. The root sheet in this project does nothing except hold the
subsheets, and the subsheets are used only as additional pages in the schematic.

NOTE This is the simplest way to create multi-page schematics in KiCad.
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Inspecting a schematic
Find tool
The Find tool searches for text in the schematic, including reference designators, pin names, symbol fields,
and graphic text. When the tool finds a match, the canvas is zoomed and centered on the match and the text

is highlighted. Launch the tool using the  button in the top toolbar.

The Find tool has several options:

Match case: Selects whether the search is case-sensitive.

Words: When selected, the search will only match the search term with complete
words in the schematic.
When unselected, the search will match if the search
term is part of a larger word in the schematic.

Wildcards: When selected, wildcards can be used in the search terms. ? 
matches any single character, and
*  matches any number of characters. Note
 that when this option is selected, partial matches are not
returned: searching
for abc*  will match the string abcd , but searching for abc  will not.

Search pin names and numbers: Selects whether the search should apply to pin
names and numbers.

Search hidden fields: Selects whether the search should apply only to visible
fields or if it should include
hidden symbol fields.

Search the current sheet only: Selects whether the search should be limited to
the current schematic sheet

or to the entire schematic.

There is also a Find and Replace tool which is activated with the  button in the top toolbar. This tool

behaves the same as the Find tool, but additionally can replace some or all matches with different text.
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If the Replace matches in reference designators option is checked, reference designators will be modified
if they contain matching text. Otherwise reference designators will not be affected.

Net highlighting
An electrical net can be highlighted in the schematic editor to visualize all of the places it appears in the
schematic. Net highlighting can be activated in the Schematic Editor or by highlighting the corresponding net

in the PCB editor when cross-probe highlighting is enabled (see below). When net highlighting is active, the
highlighted net will be shown in a different color. By default this color is pink, but it is configurable in the
Color section of the Preferences dialog.

Nets can be highlighted by clicking on a wire or pin using the Highlight Net tool in the right toolbar ( ).

Alternatively, the Highlight Net hotkey ( ) highlights the net under the cursor.

Net highlighting can be cleared by using the Clear Net Highlight action (hotkey ) or by using the Highlight
net tool on an empty region in the schematic. By default,  also clears net highlighting, but this can be
disabled if desired in Preferences → Schematic Editor → Editing Options.

Cross-probing from the PCB
KiCad allows bi-directional cross-probing between the schematic and the PCB. There are several different

types of cross-probing.

Selection cross-probing allows you to select a symbol or pin in the schematic
to select the corresponding
footprint or pad in the PCB (if one exists) and
vice-versa. By default, cross-probing will result in the display
centering on
the cross-probed item and zooming to fit. This behavior can be disabled in the
Display Options

section of the Preferences dialog.

Highlight cross-probing allows you to highlight a net in the schematic and PCB
at the same time. If the
option "Highlight cross-probed nets" is enabled in the
 Display Options section of the Preferences dialog,

highlighting a net or bus in
the schematic editor will cause the corresponding net or nets to be highlighted
in
the PCB editor, and vice versa.

Electrical Rules Check
The Electrical Rules Check (ERC) tool checks for certain errors in your schematic, such as unconnected pins,
unconnected hierarchical symbols, shorted outputs or other illegal connections, etc. ERC violations are

reported as errors or warnings depending on the severity of the issue detected.

`

~

Esc
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ERC is imperfect and cannot detect all errors, but it can detect many common issues and oversights. All
detected issues should be checked and addressed before proceeding. The quality of the ERC is directly

related to the care taken in declaring electrical pin properties during symbol creation. If symbols are
designed incorrectly, ERC will not report accurate information.

ERC can be started by clicking on the  button in the top toolbar and clicking the Run ERC button.

Any warnings or errors are reported in the Violations tab, and markers for each violation are placed in the
schematic so that they point to the relevant part of the schematic. Warnings are indicated by yellow arrows,
and errors have red arrows. Excluded violations are shown as green arrows.

NOTE Selecting a violation in the ERC window jumps to the selected violation
marker in the
schematic.

The numbers at the bottom of the window show the number of errors, warnings, and exclusions. Each type
of violation can be filtered from the list using the respective checkboxes. Clicking Delete Markers will clear

all violations until ERC is run again.

Violations can be right-clicked in the dialog to ignore them or change their severity:
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Exclude this violation: ignores this particular violation, but does not
affect any other violations.

Change severity: changes a type of violation from warning to error, or error
to warning. This affects all
violations of a given type.

Ignore all: ignores all violations of a given type. This test will now
appear in the Ignored Tests tab rather
than the Violations tab.

You can also exclude the selected marker with Inspect → Exclude Marker, and show or hide each category
of marker (errors, warnings, and exclusions) with the View menu.

Excluded and ignored violations are remembered between runs of the design rule checker.

ERC example
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There are three errors in the screenshot above.

Two outputs have been connected together (red arrow at right).

Two inputs have been left unconnected (red arrows at left). This is actually two errors per pin: each pin is
unconnected, and each pin is an input pin that is not driven by an output pin.

Selecting an ERC marker displays a description of the violation in the message pane at the bottom of the
window.

Power pins and power flags
It is common to have an "Input Power pin not driven by any Output Power pins" error on power pins, as
shown in the example below, even though the power pins seem to be properly connected to a power rail.

This happens in designs where the power is provided through connectors or other components that are not
marked as power outputs. In these cases ERC won’t detect any Output Power pins connected to the net and
will determine the Input Power pin is not driven by a power source.
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To avoid this warning, connect the net to PWR_FLAG  symbol on such a power net as shown in the following
example. The PWR_FLAG  symbol is found in the power  symbol library. Alternatively, connect any power

output pin to the net; PWR_FLAG  is simply a symbol with a single power output pin.

Ground nets often need a PWR_FLAG  as well, because voltage regulators have outputs declared as power

outputs, but their ground pins are typically marked as power inputs. Therefore grounds can appear
unconnected to a source unless a PWR_FLAG  symbol is used.

For more information about power pins and power flags, see the PWR_FLAG  documentation.

ERC Configuration
The Violation Severity panel in Schematic Setup lets you configure what types of ERC messages should be

reported as Errors, Warnings, or ignored.
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The Pin Conflicts Map panel in Schematic Setup allows you to configure connectivity rules to define
electrical conditions for errors and warnings based on what types of pins are connected to each other. For
example, by default an error is produced when an output pin is connected to another output pin.

Rules can be changed by clicking on the desired square of the matrix, causing it to cycle through the choices:
allowed, warning, error.
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